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1 OVERVIEW

The IndigoVision License Plate Recognition system consists of three main components:

* Innovis Runtime - This is the core application that performs the License Plate
Recognition (LPR) process. It also manages related activities, for example, data and
image storage, white/black list checking, communication with external programs and
devices. This information is managed in a Project.

* Innovis WatchDog - This application monitors the Innovis Runtime application and
restarts it automatically in the event that the Runtime application stops running.

* Innovis Wizard - This application lets you define the Innovis Runtime’s basic
operating parameters for the project and to monitor the Runtime’s activity. It also
displays images processed by the LPR.

It also performs searches in the database for history of stored recognitions and related
snapshots taken at the time of the LPR transit.
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INSTALLATION

To start the installation process, locate and execute the Setup_Innovis_Runtime_
<version>.exe installation file.

Follow the on-screen instructions
For the initial installation ensure that the Install VS2010 libraries is enabled.
At the end of the installation three application icons are added to your desktop:

¢ Innovis Runtime
* Innovis WatchDog
¢ |nnovis Wizard

License registration

Notice

When you first start the Innovis Runtime application, you are prompted for a License Key
string.

Contact order.mgmt@indigovision.com for the license key details. In the email provide
the following:

* Your order details
» Registration code displayed on screen

After you have your registration key, type or copy-paste it into the license registration key
dialog and select Register.

Registration Code

al-cl-d9-91-9d-7a

License Key

I Register ‘

[ Exit |

Figure 1: License registration key dialog

The license is strongly dependent on the hardware configuration of the PC on which the
software is being installed. Even slight hardware modifications, such as plugging in a USB
key, may deactivate the license. In such case, undo the modification and run the software
again.
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Updating the installation

If you need to update your current installation, the new installation overwrites the project
folder.

Before running the update setup, if you want to install in the same folder, you need to make a
backup of the following folders and files:

* Project folder
» The registration.hex file - contains your license code

Both the project folder and the registration.hex file are installed by default in
\Innovis\Innovis-Runtime.
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3 USING INNOVIS RUNTIME

This application performs the License Plate Recognition (LPR) process. All the configuration

is held in a project.

The project is created and configured using the Innovis Wizard. Projects are used to manage
configurations, for example, cameras per lane, overview cameras, and integration with

Control Center

InnoVis Runtime normally runs in the background and does not have a graphical user
interface. To show the GUI right click on the systray icon and select Show Main Window.

The following window is displayed:

Add lane
6 - Add lan
ad Trigg
Load Integrators

Time

Plate

Image

Country *

29/11/
29/11/1
29/11/
29/11f
29/11f
29/11f
29/1Y/.
29/11/

An e

4

LU}

EWAING
CXEANF
DGm5SK
EPOBSYN
BGARME
DBSBSFF
EVBMEXG
ewillws

FA A TR

D\innowar...
DAinnowar...
DAinnowar...
DAinnowar...
DAinnowar...
DAinnowar...
D\innowar...
DAinnowar...

[

380
380
380
380
380
380
380
380

aon

Figure 2: Innovis Runtime main window

Image retrieval

Using the main window it is possible to see the images processed by the LPR module and

the results of the recognition process.

Double click on one of the recognition log’s lines to open another window that shows the
image captured by the LPR camera at the moment of the transit. A close-up of the license

plate is also provided.
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IMAGES: 01/04

16:22 - Test Site - Lane: ROI1 - Plate: RPMB0E

Figure 3: LPR image window

If an overview camera has been defined, in addition to the image captured by the LPR
camera, one or more overview images are also displayed. You can define the number of pre-
and post-event images to be displayed, as well as the time interval between each frame
capture. Use the arrow buttons to scroll through the images.

Figure 4: Overview images windows

Left click on the image to zoom-in and right click to zoom-out.

Closing Innovis Runtime

Notice

The Innovis Runtime GUI can be hidden by clicking the close button or by right-clicking on
the software systray icon and selecting Hide Main Window.

From the systray icon is also possible to upgrade your license and close the application.

If you want to permanently stop the Innovis Runtime application you must first stop the
Innovis WatchDog application.

» For more information, see "Using Innovis WatchDog" on page 11.

10
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4 Using INNOVIS WATCHDOG

The Innovis WatchDog application automatically starts at boot and checks if Innovis
Runtime application is running.

If the Innovis Runtime application is not running, the Innovis WatchDog application restarts
it.

The graphical user interface of this application is normally hidden. However to show the user
interface, right-click on the systray icon and select Show Main Window.

The following window is displayed:

€ Innoware - Innovis Watchdog 1.4 = O X

Reboot PC: MO ~ Update Parameters
Reboot Time (HH:MM): |23;59 |

Restart Runtirme: YES e
Reboot Time (HH:MM): (23,50 |

s not running... restart it
untime started

Figure 5: Innovis WatchDog interface
The following settings are available:
* Reboot PC - If YES is selected, your PC will be rebooted at the time specified in the

Reboot Time field.

* Reboot Runtime - If YES is selected, the Innovis Runtime application restarts at the
time specified in the Reboot Time field.

* Click Update Parameters to apply changes.
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5 USING INNOVIS WIZARD

Innovis Wizard is used to perform two tasks:

» Lets you define and modify the operating parameters of Innovis Runtime
» Displays the activity of Innovis Runtime and manages data and images related to
license plate recognitions.

Vided —/Gﬂgﬁ = ranst Wanager
{ L Ste Lane Plate
3 - g

Trailer plate *

|

ENSREZR

2006 11-30 0eld 47.647
Test Site.
Gate

Figure 6: Innovis Wizard user interface

Project setup
Before starting the Innovis Runtime application the basic operating parameters must be
defined.
Those parameters are stored in a collection of files saved in the project folder of the Innovis
installation.

General parameters
Click Settings <% to enter the following general project information:

e
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File VWiew Layout Project

ﬁﬁ Project Information
3

B Software Access

Username admin
¢® Password password
v 1. Lane Access Mode Do not request password
Add Lane Site Information
e Site Mame Test Site
e Site ID 1
e [leme Bl Database Settings
>l D e
Mame InneSCL_1133
‘q— Username innoware

Edit Lane Pazsword e

Day on DB 5

B Auto remove
Whitelist No

Tl

Confirm

Cancel

Figure 7: General project settings

Software access

+ Username and password of the administrative user
»  Whetherit is necessary or not to provide the administrative credentials to modify the
operating parameters

Site information

+ Site name - Name of the site in which Innovis applications are running
» Site ID - Numeric value identifying the site. This is used to retrieve statistics and in
case the site will be managed by InnoWeb

Database settings

The data related to license plate recognitions are normally stored in a local database which is
located in the Innovis installation folder.

Only if the site is part of a network of sites monitored centrally by InnoWeb, the connection to
a central database management system based on Microsoft SQL Server must be defined
using the following fields.

» IP -IP address or host name of the server hosting SQL Server, optionally followed by
the instance name

» Name - Name of the database in which the data are stored

» Username & Password - Credentials of the database owner

» Days in DB - Number of days, in terms of data and images, to be stored in the local
database before deletion. Only the data already synchronized with the central
database will be deleted. If the connection is not available, the recognition data will be
stored locally without time limits.
After the remote connection has been restored, the synchronization is performed
automatically. Set a minimum value of 1.

14
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Caution

Do not set the Days in DB to 0.

Auto remove

The white listed license plates, whose authorization time has expired, that are automatically
deleted.

Add new lane

Caution

-
After you have defined the general parameters, click Add Lane #ddlanz
You must add at least one Lane.
Up to 16 lanes can be managed by the application.
There are two areas that need to be defined when adding a new lane:

* Video source definition
» Lane operating parameters setup

Video source

* Name: Name of the camera to be used as a source of images.
* Video Source Type: InnoVis is currently capable of supporting:
* Any RTSP/ONVIF h264 camera
* Axis (MJPEG and MPEG4)
» IndigoVision proprietary video streams
» Basler Pylon protocol
+ HTTP/MJPEG generic cameras

The information requested in the other fields are dependent on the source selected.
For example, selecting RTSP VideoSource, the following options are available

* URI: Uniform Resource |dentifier of the video source.
* Username & Password: Credentials needed for accessing the video source.
*  Max FPS: Number of Frames per Second to be received and processed.

The parameters selected for Max FPS can have an impact on your CPU usage. It is
recommended that you select values between 5 and 8 FPS for parking and access control
and up to 15 FPS for free flowing traffic.

Lane parameters

* Lane Name - Name of lane to be managed.
* Recognition Type - Two different operating modes can be selected:
» Parking: For access control and vehicle speeds up to 50 km/h
* FreeFlow: For free flowing recognition up to 110 km/h
For higher speeds, specifically designed applications need to be used.
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Use IndigoVision Postprocessor - Select YES to manage the parameters required
for integration with IndigoVision Control Center and NVR-AS.

b For more information, see "Integration with IndigoVision Control Center" on page 21.

ROI Settings

Char Min Height. minimum vertical size in pixels of the license plate’s characters.
Note that for optimal performance, the advisable minimum vertical size is 24 pixels.
Char Max Height. maximum vertical size in pixels of the license plate’s characters.

Delta ROI X (%): percentage of horizontal dilation of the area, with respect to the
license plate position and size, in which to perform the search of the license plate in
the subsequent frame.

Delta ROI' Y (%): percentage of vertical dilation of the area, with respect to the license
plate position and size, in which to perform the search of the license plate in the
subsequent frame.

Snapshot settings

Snapshot Folder. file system folder in which to store the snapshots taken at the
moment of recognition from the LPR camera.

ONVIF Streaming Port. TCP port number over which to re-stream the images coming
from the video source. Use -1 to disable this feature.

Server Comm. Port. TCP port number on which the InnoVis’ internal server listens
for socket connection, Use -1 to disable this feature.

This feature is only used for integration with third party applications, that have a socket
interface for listening for metadata to be parsed and processed. It is not used by the
IndigoVision system.

Whitelist Tolerance: the number of characters, for a given position, by which two
plates can differ and still be considered as belonging to the white list.

It can be useful to still allow access in the event of detection failures due to difficult
reading conditions, for example if the license plate is dirty or damaged.

Delta Whitelist. if active, for each new recognition the license plate code will be
automatically added to the white list and the authorization expiration time is set to the
moment of the recognition plus the number of minutes set in this field.

This is useful in situations in which there is limited free parking time after which a toll
must be paid, for example, car parks for shopping malls.

ROI (Region Of Interest) definition

The area(s) in which the License Plate Recognition has to be performed can be defined by
left-clicking on the image and drawing at least 4 lines to delimit a polygon. Press the Escape
key to cancel drawing.

Holding down CTRL while dragging the mouse pointer lets you design rectangular ROls.

After selecting the last point to complete the polygon, you are prompted to apply the changes
and to restart Innovis Runtime. This lets the application use these new settings.

Using the Innovis Wizard you can define only one lane for each camera.

After the initial setting, the definition of all the virtual lanes’ ROI can be performed using just
the Innovis Wizard.

16
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Remove a lane

i@
Yo
Toremove a lane click Rem. Lane Rem.lane and select the name of the lane to be removed.

You are prompted to also remove the associated video source.

Edit a lane

@)
°

Click Edit Lane EditLane gnd select the name of the lane to be modified.
After selecting the lane to edit, click OK to open the operating parameters window.
If required, the video source parameters can be modified.

Only the operating parameters of the video source can be changed. You cannot change the
type of source.

» For more information, see "Add new lane" on page 15

All the operations described above can also be performed by selecting the relevant items of
the Project menu. In addition to the editing options, you can manually restart Innovis
Runtime.

You are prompted to perform a restart any time the operating parameters are changed.

After a new project has been defined, Innovis Runtime must be started manually or by
accepting the prompts that are displayed after making a change to the project settings.

Monitoring activity

Project

Innovis Wizard, in addition to the project definition functionality, also lets you monitor the
general activity of the Innovis Runtime application.

Through its interface, the images coming from up to 16 lanes can be displayed
simultaneously.

The layout of the interface can be selected using the layout icons on the left side of the main
window or selecting the item from the Layout menu.

Using the View menu you have access to other monitoring and management options.

The project option lets you review the main operating parameters of the project.

Transit Manager

The Transit Manager displays real-time results of the license plate recognition and the related
shapshots

The log’s data rows have different background colors according to the result of the check
against the license plate black/white list:

* Green: in White list

* Yellow: in White list — authorization expired
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* Red: not in White list
« Black: in Black list

Double-click a row in the results log to display the image captured by the LPR camera.

If an overview camera has been defined in the project, the related overview images are
shown.

Left-click on an image to zoom in and right-click to zoom out.

Use the left and right arrow buttons on the screen to browse through the images.

Transit Database Manager

The Transit Database Manager lets you perform searches in the recognitions database.
The searches are based on:

+ License plate code, or a part of it:

» Underscore (_) sign is the wildcard for a single character.

« The percentage (%) symbol is the substitute for zero or more characters.
* Timeinterval
* Type of alarm detected

Click Execute Query to find and display the records that match the search criteria.
Double-click a row in the results log to display the image captured by the LPR camera.

If an overview camera has been defined in the project, the related overview images are
shown.

Left-click on an image to zoom in and right-click to zoom out.
Use the left and right arrow buttons on the screen to browse through the images.

Click Export Results to export the retrieved data to an Excel file for further statistical
analysis.

Black/White List Manager

The Black/White List Manager lets you manage a list of White (transit allowed) or Black
(sensitive license plates, often related to criminal actions) vehicles.

To avoid possible errors and speed up data entry, the license plate code can be inserted
automatically by right-clicking on a record in the Transit Manager's license plate log.

The Badge Code field is designed to host the ID of a badge or of any other device used for
authentication by an access control system.

This value can be sent to a serial port, whether local, connected via network or supported
cameras and converted into the Wiegand protocol to allow Innovis applications to act like an
access control authorization device.

If you need to insert many license plates into these lists, the import can be performed from an
Excel file.

License plate list template

The following defines the Excel spreadsheet column headings that are required when creating
a license plate list for import.

* Name

* Surname

18

User Guide - v1



LPR powered by InnoWare 5 Using Innovis Wizard

Address

Zip

City

Phone

Plate
AuthorizationStart
AuthorizationStop
Blacklist

0= Not in blacklist, 1=in blacklist. This value is set according to the choice made using
the white/black list manager of the Innovis Wizard. If set to 1, the dates, even if
present, are ignored.

Description

IDBadge

Templates Manager

The term template refers to a specific combination of numbers, letters, spaces and symbols
that, together with other details, identifies a specific country’s license plates.

The LPR applications are country and font independent. Therefore the use of templates is not
strictly required.

The use of templates lets the system resolve ambiguities, for example 1 and “I”, 0 and “O”.
This improves the recognition accuracy.

Use Template: Enables template management.

Discard res. If templ. not found: if enabled, the recognition results that don’t belong
to any of the enabled templates will be discarded. This can be useful in the case of
wide fields of view in which character strings other than a license plate could be seen,
like on trucks and similar vehicles.

Discard Min.Th(%): the percentage of confidence below which a recognized license
plate is not considered to belong to any template and consequently discarded if the
previous parameter is enabled.

Force characters substitution: if enabled, ambiguities resolution in accordance with
the template rules will be performed.

Substitution Min. Th. (%): the percentage of confidence above which a recognized
license plate is considered to belong to some templates.

If the previous parameter is enabled, the character substitution will be performed.

Currently the following country templates are provided:

ITA - Italy

FRA -France

BEL - Belgium

NLD - Netherlands
ESP - Spain

PRT - Portugal

GBR - United Kingdom
LUX - Luxemburg

ZAF - South Africa
MLT - Malta

Templates for other countries may be available on request.

User Guide - v1
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A INTEGRATION WITH INDIGOVISION CONTROL
CENTER

The integration between the LPR applications and IndigoVision Control Center is managed
using a post-processing plugin, included with the LPR installation files.

The integration is enabled by selecting YES to the related parameter in the lane setup

window:
Insert Lane Parameters
Lane Name Lane 1 ~
Recognition Type Parking
g
B ROl Settings
Char Min Height 18
Char Max Height 50
Delta ROI X (%) 10
Delta ROI'Y (%) 20
B Snapshot Settings
Snanchnt Faldar Fhimn

Figure 8: Enable integration plugin for post-processing data
Based on the data coming from the lane, the plugin performs the following actions:
» Checks the presence of the license plate in the white or black list
» Creates a bookmark on the NVR
* Sends a data record to the NVR
» Generates an alarm in the Alarm server, if configured in IndigoVision Control Center.

Below is an example list of the parameters that can be managed by the plugin:
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Indigo Post Processor Settings

Post Processor name
Check Whitelist
Check Unknown
Check Expired

Check Blacklist

In Whitelist Code
Unknown Code
Expired Whitelist Code
Blacklist Code

Transit Direction
Whitelist Tolerance
Blacklist Tolerance
String 2 send (with space):
MNVR IP Address:
Alarm Server IP Address:
Carmera Service UID:
Runtime IP:

Whitelist String:
Unknown String:
Expired String:
Blacklist String:

Delta Time:

Send Data

Send Alarm

Send Bookmark

ID Data Source

IV-CC

Inceming
1
1

Event #ALARMCODE# : #ALARMINDEX# - Lic.PLate: #PLATE# - Lane: #LANENAME# - Site |D: #5ITEID=

192.168.67.129
192.168.67.129
urn:uuid:c089e2ab- d3f0-d46d-0337-4227d8d057F0
192.168.67.1
WhiteList

Plate Unknown
Auth.Expired
BlackList

-5000

YES

YES

YES

1

Update

Cancel

Figure 9: Example of data processed by the Innovis plugin

Data managed by the integration plugin

Data parameter

Description

Check
Whitelist/Unknown/Expired/Blacklist

In
Whitelist/Expired/Unknown/Blacklist
code

Transit direction

Whitelist/Blacklist Tolerance

Allows enabling/disabling the related controls.

If allthe options are disabled, the IndigoVision Postprocessor will send the data related to

each transit, no matter the alarm condition.

Associates each event with an IndigoVision Control Center external detector input number.

Incoming or outgoing.

Number of different characters that makes equivalent two license plates codes.

String to Send Content of the string to send as bookmark or data record.
This can be composed by a mix of static words and dynamic tags, delimited by the hash sign
(#) and spaces:
#DATETIME# = Date/Time of the transit
MNER S = Vehicle Owner
#OWNERSURNAME#
#PLATE# = License Plate
#LANENAME# = Lane Name
#LANEID# = LanelD
#SITEID# = Site ID
#BADGEID# = Badge code (for Wiegand integration)
#IMGFILE# = Image file name and path
#TRANSITDIR# = Transitdirection
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Data parameter

Description

NVP IP Address

Alarm Server IP Address

Camera Service UID

Runtime IP
Whitelist/Unknown/Expired/Blacklist
String

Delta Time

Send Data/Send Alarm/Send
Bookmark

ID Data Source

#ALARMCODE#
#ALARMINDEX#

Alarm Code
Alarm Description

The IP address of the IndigoVision NVR. This allows bookmarks to be sent to the
appropriate NVR. Care should be taken to choose the appropriate NVR for the camera in
question.

The IP address of the Alarm Server. In most cases this will be the same as the IP address of
the NVR.

Camera Service ID as per the camera’s properties in IndigoVision Control Center. This can
be copied directly from the Control Center user interface, on the Setup screen.

IP address of the workstation on which InnoVis is running.

To be used in the definition of the external alarm source in the IndigoVision Control Center.

Text description to be used for alarm events within the bookmark string..
Used to assign a value to the #ALARMIND EX# tag within the bookmark.
Number of seconds to be subtracted (typical use) or to be added to the actual recognition

time to obtain the time at which the Bookmark and/or Data Records are set in IndigoVision
Control Center.

Anticipating the reading time allows you to start playing the recorded video immediately
before the vehicle passes.

Flags to enable/disable sending the related events to IndigoVision Control Center.

The ID of the Data Source linked to the lane.
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